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Using Microsoft Word 
 

Paragraph Formatting 

Every time you press the full-stop key in a document, you are telling Word that you are finishing one 

sentence and starting a new one. Similarly, if you press the [Enter] key, you are telling Word that you 

are finishing a paragraph and starting a new one. The difference is you can always see the full-stop at 

the end of a sentence. You can’t normally see the end of a paragraph. Paragraph endings are marked 

by a character that is usually hidden. You can however, display these and many other hidden 

characters. Being able to see these hidden characters can sometimes be a useful way to find the cause 

of problems with the way your document looks. 

Exercise 1. Displaying Hidden Characters 

1) Open the Word_2010 document. 

2) Click the Show/Hide icon  on the ribbon. 

 

Paragraph endings will be indicated by the ¶ symbol. You will also see other hidden characters 

shown, such as tabs and blank spaces. 

3) Click the icon again to turn off hidden characters. 

 

Note Any changes to paragraph formatting will affect the entire paragraph. Only character 
formatting options will affect parts of a paragraph. This means that if you want to format a 
paragraph, you don’t have to select the entire paragraph first. Simply selecting part of the 
paragraph or even just clicking inside the paragraph will be enough. 
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Paragraph Spacing Options 

You can use the paragraph spacing options to adjust the amount of space before paragraphs, after 

paragraphs and between each line in a paragraph. 

Exercise 2. Adjusting Paragraph Spacing 

1) Click in the first paragraph of the document (not the heading). 

2) Click the Paragraph dialog box icon in the ribbon as shown to below. 

 

You can also right-click on the paragraph and choose  from the shortcut menu. The 

Paragraph dialog will appear.  
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3) In the Spacing section you can adjust the paragraph spacing options. Click on the up arrow next 

to the Before option until the box shows 12pt like the example above.   

4) Do the same for the After option so that there will be 12 points of blank space before and after the 

paragraph. 

5) Click OK to make the change. There will now be additional space before and after the paragraph. 

6) Increase the spacing after the paragraph to 18 points. 

7) Change all of the paragraphs with the dot points so that they each have 18 points of space after 

the paragraph and 12 points of space before. 

 

Note Instead of always typing blank lines in a document; it is often better to use paragraph 
spacing to create space instead. Blank lines that serve no purpose other than creating 
space can cause problems later, especially when you begin working with styles. 
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Exercise 3. Adjusting Line Spacing 

1) Click in the first paragraph (Word 2010 offers). 

2) Display the Paragraph formatting options. 

 

3) Change the Line Spacing option to 1.5 Lines. 

4) Click OK when done. The lines of test will have more space between them. This can also be done 

using keyboard and toolbar shortcuts. 

5) Press [Ctrl] [2]. This will change the paragraph to double line spacing. 

6) Press [Ctrl] [1]. This will change the paragraph to single line 

spacing. 

7) Press [Ctrl] [5]. This will change the paragraph to 1.5 line spacing. 

8) Click the arrow next to the Line Spacing icon  on the ribbon. 

A list of line spacing options will appear. 

9) Click on 1.0 to change the spacing to single line spacing. 

10) Save changes to the document. 
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Alignment and Indentation 

You will have seen that the paragraph formatting dialog also contains options for aligning text and 

indenting text. In both cases, the formatting can be changed in the dialog box itself, or by using 

additional shortcuts. 

Exercise 4. Changing Paragraph Alignment 

1) Click in the first paragraph on the page under the main heading. 

Display the Paragraph formatting dialog. 

2) You will see a drop-down list next the Alignment. Select 

Centered from the list.  

3) Click OK to make the change. The text in that paragraph will be 

lined up horizontally with the centre of the page. 

You can also change the alignment options using shortcuts. 

4) Change the paragraph to Right alignment by clicking the icon  or by pressing [Ctrl] [R]. The text 

in the paragraph will be arranged to the right of the page so that it lines up with the right page 

margin. 

5) Change the paragraph to Centered alignment by clicking the  icon or by pressing [Ctrl] [E] (The 

[Ctrl] [C] shortcut is already allocated to copying). 

6) Change the paragraph to Justified by clicking the icon  or by pressing [Ctrl] [J]. The text in the 

paragraph will be evenly spaced so that both sides of the paragraph will line up with the left and 

right page margins. 

7) Change the paragraph back to Left alignment by clicking the icon  or by pressing [Ctrl] [L]. The 

text in the paragraph will be arranged to the left of the page so that it lines up with the left page 

margin. 

Note The alignment icons will always show which alignment is being used for the currently 
selected paragraph. You can also tell which way your text is aligned when you move your 
mouse pointer over the text; the following example shows how the pointer looks when it’s 

over left aligned text.   
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Exercise 5. Changing Indentation Options 

1) Make sure the insertion point is still in the first paragraph of the document. 

2) Click the Increase Indent icon  on the toolbar (or press [Alt] [Shift] []). The paragraph will be 

indented by a small amount (a little over a cm). 

3) Click the Decrease Indent icon  (or press [Alt] [Shift] []) to return the paragraph to its normal 

position. These shortcuts can indent a paragraph from the left of the page but additional options 

are available elsewhere. 

4) Display the Paragraph formatting options. Note the Indentation options in the middle section. 

 

The Left and Right options allow you to change how much the paragraph is indented from the left 

page margin and right page margin. The remaining options affect only the first line of the paragraph. 

The Special option allows you to choose a First Line indent (so the first line is indented more than the 

rest of the paragraph) or a Hanging indent (so the first line is indented less than the rest of the 

paragraph). The By option specifies how far the first line will be indented by. 

5) Change the Indentation options so that they appear the same as the example below. 

 

The left and right sides of the paragraph will be indented 1cm from the page margins. The first line 

of the paragraph will be intended by a further 1cm. 

6) Click the Undo icon or press [Ctrl] [Z] to return the margins to their previous state. 



Using Microsoft Word 2010  Paragraph Formatting 

© Steve O’Neil 2005 Page 7 of 15 http://www.oneil.com.au/pc/  

These margin changes can also be made more directly by using the markers on the ruler. 

7) If the rulers are not visible on your document, click the View Ruler icon at the top of the 

scrollbar to turn them on.  

If you look at the horizontal ruler at the top of the document, you will notice several markers on each 

end of the ruler. These can be used to adjust indents for the selected paragraph(s) by using your 

mouse. 

8) Make sure the first paragraph is still selected. 

9) Move your mouse over the Right Indent marker  on the ruler and drag it about 1cm to 

the left. 

10) Move your mouse over the Left Indent marker  on the ruler and drag it to the right 

approximately ½ a cm. The first line and hanging indent markers will also move. 

Notice that when you drag the marker, it moves in small steps, which can make it hard to get it to 

exactly the position you want. 

11) Hold down the [Alt] key and drag the Left Indent marker so that it is exactly on the ½cm mark. 

Holding down [Alt] while dragging allows you to be more precise with measurements. 

 

12) Drag the First Line Indent marker  so that it is on the 1cm mark. You can do it with or 

without the [Alt] key. 

13) Drag the Hanging Indent marker  so that it is on the 2cm mark. A Hanging Indent is 

created when the first line is indented less than the rest of the paragraph. 

Your paragraph should end up looking similar to the one below. 
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Exercise 6. Page Breaks and Other Breaks 

Page breaks allow you to specify where a new page will begin in a document. You can create page 

breaks by manually inserting a break where you need one. You can also specify breaks in your 

paragraph formatting so that a particular paragraph, such as a heading, will always begin on a new 

page. 

1) Scroll down to the Save time and simplify your work heading and place your insertion point at the 

beginning of the word Save. 

2) From the Insert tab click Page Break. 

 

3) Click the Show/Hide icon  on the ribbon to display hidden characters. 

4) Scroll to the previous page to see the page break indicated. 

 

5) Click the  icon again to hide hidden characters. 

6) Click the Undo icon  or press [Ctrl] [Z] to remove the page break. We will try some other 

methods for adding a page break. 

7) Make sure your insertion point is still in front of the heading and press [Ctrl] [Enter]. This is a 

shortcut for manually adding a page break. 

8) Undo once again to remove the page break. Now we will try adding a page break using the 

paragraph formatting options. 

9) Click the Undo icon  or press [Ctrl] [Z] to remove the page break. 
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10) Display the Paragraph format dialog. 

11) Make sure the Line and Page Breaks tab is selected at the top of the Paragraph options. 

 

12) Click the Page break before option and click OK. Since this page break is part of the paragraph 

formatting, this paragraph will now always begin on a new page, even when text is re-arranged in 

the document. For headings, this is often better than putting in a manual page break as we did 

before. 

13) Use the Paragraph formatting option to place a page break before each of the following headings 

in the document. 

 Work together more successfully 

 Access your information from more places 

Remember you can use the [F4] shortcut to repeat rather than open the Paragraph options for each 

one. 

 

Tip If you want to create a new line without starting a new paragraph, you can insert a line 
break by pressing [Shift] [Enter]. The new line will retain the paragraph formatting because it 
will still be a part of the same paragraph. 
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Page Headers & Footers 

Headers and footers allow you to have similar information, such as page numbers or document titles, 

repeated at the top or bottom of every page. For example, on this particular page, the header that is 

repeated on every page shows Using Microsoft Word 2010 and Paragraph Formatting. The footer at 

the bottom of each page shows the filename of this document and the page numbers in the document. 

Exercise 7. Adding Headers & Footers 

1) Make sure the Word_2010 document is still open. 

2) From the Insert ribbon tab click the Header icon. A list of header templates will appear. 

 

3) Click the first option (Blank). 

 

A blank header will appear at the top of the page with a placeholder available for you to type text in 

to. 

 

The words Type text show where your text will appear. Notice that while you are editing the header, 

a new Header & Footer Tools tab appears on the ribbon. Under this tab you will see many icons for 

working with Headers and Footers, including several that can add useful elements like dates and 

page numbers. 

 

4) Type Microsoft Word 2010. The text you type should appear where Type text was previously. 
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5) Click the Go to Footer icon on the Navigation ribbon group. You will be taken to the footer 

at the bottom of the page. 

 

6) Click the Quick Parts icon on the Insert group of the ribbon. 

7) When the list of AutoText options appears, click on . 

The Field dialog will appear. 

 

8) From the list of field types on the left choose FileName. The options in the middle allow you to 

select how the filename will appear for the selected field (in this instance it provides options for 

upper and lower case). The option on the right lets you choose whether or not you want the 

filename to include the location of the file. 

 

9) Click OK to insert the filename. 

The filename will be inserted in the left part of the footer. If you rename the file, the filename will 

update in the footer the next time you open the document. 

10) Press the [Tab] key to move to the middle section of the document. 

11) Press the [Tab] key a second time to move to the right section of the footer. 
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12) Type Page followed by a space. 

13) Click the Page Number icon under the Header & Footer ribbon group. 

14) From the menu which appears select Current Position and then select Plain Number. 

 

15) Add another space. 

16) Type of followed by a space. 

17) Click on the Quick Parts icon and select Field again. 

18) This time choose NumPages for the field type and click OK. 

The right section of your footer should now show the page number on each page as well as the total 

number of pages. 

19) Scroll down through the pages to see the page number on each page in your footer. 

The finished header and footer should look similar to the example below. 

 

 

 

20) Click the Close Header and Footer icon to return to regular page editing. 
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Exercise 8. Modifying the Header and Footer 

1) Select the Insert tab on the Ribbon. 

2) Click the Insert icon and then choose  from the bottom of the menu. 

3) Click after the text Microsoft Word 2010. 

4) Press the [Tab] key twice to move to the right side of the header. 

5) Click the Date & Time icon from the Insert group on the ribbon. 

 

6) Select the second date format in the list. 

7) Check the Update Automatically box. This will ensure that the date will update each time you open 

the document. 

8) Click OK to add the date. 

9) Click the Close Header and Footer icon. 

10) Move your mouse over the footer at the bottom of the page. 

11) Double-click to edit the footer. When you have already created a header and 

footer, this is easier than going to the View tab on the ribbon to edit them. 

12) When the Header and Footer Tools tab appears on the ribbon, click the Page Number icon and then 

select  from the menu that appears.  
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13) Change the number format to the roman numerals option shown above and click OK.  

14) To change the format for the total number of pages also, first 

click on the total page number so that the field is highlighted. 

Then right click on the total pages number and select Edit Field. 

15) Select the roman numerals format from the list in the middle of 

the Field dialog and click OK. 

 

16) Move your mouse over an area of the page outside the footer area and double-click. This is a 

quick way to end header and footer editing. 

 

17) Save changes and close the document. 

18) Open the document called Paragraphs Exercise and follow the instructions in the document to 

practice paragraph formatting. 

19) Save and close the document when you are done. 
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Shortcuts Covered in This Section 

 

Alt Shift  Increase paragraph indent. 

Alt Shift  Decrease paragraph indent. 

Ctrl 1 Single line spacing. 

Ctrl 2 Double line spacing. 

Ctrl 5 1.5 line spacing. 

Ctrl E Centre align paragraphs. 

Ctrl J Justify aligns paragraphs. 

Ctrl L Left align paragraphs. 

Ctrl R Right align paragraphs. 

Ctrl Enter Insert a page break. 

Shift Enter Insert a line break in a paragraph. 

 


